% Texas
INSTRUMENTS December 2014

Examples Guide: MSP430 SMBus Library

1

1

MSP430
Introduction
This document is intended for the person evaluating the MSP430 SMBus Library. The APl is
accompanied by many examples that demonstrate its use; this document describes how to run
those examples, and provides commentary on how they were written.
For detailed information on developing with the SMBus Library, please see the MSP430 SMBus
Library User’s Guide.
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1.1 Supported Devices

The SMBus library and examples were developed and tested in the following MSP430 families
of devices:

Table 1: MSP430 Devices supported by SMBus Library examples

Device SMBus/I°C Interface
MSP430FR59xx | Enhanced Universal Serial Communication Interface (eUSCI)
MSP430G2xx3 Universal Serial Communication Interface (USCI)

The code examples and the SMBus library can be implemented in different derivatives of the
same family with little effort; and they can be migrated to other MSP430 devices with the same
SMBus/I’C interface with some considerations such as pin usage, memory and timeout-timer
availability.

1.2 Summary of the Examples

Each example in this software package is provided with full source code and including the
necessary project files to build the project in IAR or CCS.

The examples, with the corresponding role and slave address are listed in Table 2.
Table 2: Examples implemented in SMBus Library

Name Role Slave Address
SMB_Master00_AllProtocols Master | 0x43
SMB_Slave00 AllProtocols Slave

SMB_Master01 ReadByte Echo Master | 0x43

SMB_Slave0l ReadByte Echo Slave

SMB_ Master02 WriteWord Dimmer | Master | 0x43

SMB_Slave02 WriteWord_Dimmer | Slave

The hardware used by each example is described in more detail in Section 2.2 and their
functionality is explained in Section 3.

Examples Guide: MSP430 USB API Examples 2
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2 Running the Examples

2.1 Obtaining Code Composer Studio or IAR Kickstart

The SMBus Library and examples build and run on both the IAR and Code Composer Studio
(CCS) environments for MSP430. See the Release Notes HTML file in the SMBus Library
package for specific IAR/CCS version information.

IAR and CCS are both available in free, code-size-limited versions (8K and 16K, respectively, of
object code). Applications that require less than r 8K of memory can be run on both free
versions. Applications that require more than 8K of memory cannot be built using the free IAR
Kickstart tool. Instead, the free version of CCS can be used, or a licensed version of either
environment.

2.2 Hardware Support

Most of the examples can run on any hardware Tl sells in the eStore, supporting the devices
mentioned in Table 1. This includes:

e FR5969 LaunchPad (MSP-EXP430FR5969)
e MSP430 Value Line Launchpad (MSP-EXP430G2)
e Any FET target board for supported MSP430 derivatives

Every example has a HAL layer which can be used to initialize ports, clocks and any other
hardware used by the application and SMBus layers.

The following tables list the resources used by the examples:
Table 3: Hardware resources for example 00_AllProtocols

SMB_Master Description | MSP430FR59xx | MSP430G2xx3

00_AllProtocols | 12C eUSCI B0 USCIBO

12C_SDA P1.6/UCBOSDA | P1.7/UCBOSDA

12C_SCL P1.7/UCBOSCL | P1.6/UCBOSCL

LEDO P1.0 P1.0
LED1 P4.6 N/A
SMB_Slave | 12C eUSCI_BO USCIBO

00_AlIProtocols | 12C SDA P1.6/UCBOSDA | P1.7/UCBOSDA

12C_SCL P1.7/UCBOSCL | P1.6/UCBOSCL

LEDO P1.0 P1.0
LED1 P4.6 N/A
ADC P2.4/A7 P1.4/A4

Examples Guide: MSP430 USB APl Examples 3
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ADC trigger | TAO.1 TA1.0
IOPort P4 P1
Input Switch | P4.5 P1.3

Table 4: Hardware resources for example 01 ReadByte Echo

SMB_Master
01_ReadByte Echo

Description | MSP430FR59xx

MSP430G2xx3

12C eUSCI_BO

USCIBO

12C_SDA P1.6/UCBOSDA

P1.7/UCBOSDA

12C_SCL P1.7/UCBOSCL

P1.6/UCBOSCL

01 ReadByte Echo

LEDO P1.0 P1.0
LED1 P4.6 N/A
SMB_Slave 12C eUSCI_BO USCIBO

12C_SDA P1.6/UCBOSDA

P1.7/UCBOSDA

12C_SCL P1.7/UCBOSCL

P1.6/UCBOSCL

LEDO P1.0

P1.0

LED1 P4.6

N/A

Table 5: Hardware resources for example 02_WriteWord_Dimmer

SMB_Master Description | MSP430FR59xx | MSP430G2xx3
02_WriteWord_Dimmer | 12C eUSCI BO USCIBO
12C_SDA P1.6/UCBOSDA | P1.7/UCBOSDA
12C_SCL P1.7/UCBOSCL | P1.6/UCBOSCL
LEDO P1.0 P1.0
LED1 P4.6 N/A
SMB_Slave 12C eUSCI _BO USCIBO
02_WriteWord_Dimmer | 12C_SDA P1.6/UCBOSDA | P1.7/UCBOSDA
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12C_SCL P1.7/UCBOSCL | P1.6/UCBOSCL

LEDO P1.0 P1.0
LED1 P4.6 N/A
PWM P1.4/TB0.1 P2.4/TA1.2

2.3 Opening and building the examples

The SMBus Library examples have the following structure:

<install>
| -—driverlib <- MSP430 driverlib used to access MSP430 peripherals
| -—-smbuslib <- Contains the SMBus library itself
| ——examples
| --MSP430* <- MSP430 device supported by examples
| | --- CCS

| | -— SMB*.projectspec <- Individual project files for CCS

\

\

| | --- IAR

\ \ | -- SMB*

\ \ | |-- *.ewd/ewp <- Individual project files for IAR

\ \ | |-— *.eww <- Workspace for individual projects

\ \ | -- SMBus_Examples Workspace.eww <- Workspace containing all
\ \ examples

\ | --- Src

| | | -— SMB*

\ \ | -— main.c <- The example’s main code

\ \ |-- * HAL.c/h <- Hardware abstraction for example

\ \ |-- *.c/h <- Other source files used by application

2.3.11AR Projects

The IAR projects are grouped within workspaces. There is one workspace containing all
examples and individual workspaces for each project.

To use the examples in IAR, open the corresponding workspace file (*.eww) by selecting
File>Open->Workspace.

After doing so, one of the projects in the workspace will be highlighted in bold; this is the active
project. If a different example is desired, right-click on it and select “set as active”. If the
workspace only has one project, this will be the only option.

Examples Guide: MSP430 USB APl Examples 5
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(% SMBus_Examples_ Workspace
e Project Emulator Toals Help
D@ H@ D] %R0 | --a’\v‘k iAo db BRRS 2L
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5MB_SlaveD0_AlProtocals - MGP430FR5363 -
Files in B

B [BsMBus_Examples_Workspace
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Sara v
|-= 9 SME_STavel abyie_Echo - MoF430r ag6d

I—IBSMB Slawvel? WHIEWDI’d D\mmer MEF430FRES6EY v

Overview  SMB_Master00_allProtocols | SMB_Masterl1_ReadByte_Echo | SMB_Master(: 4 | »

x
Messages

Build

Build | Debug Log | Find in Files

E

eady Errors 0, Wamings 0

Figure 1: Active project in IAR

If desired, the active project can also be selected by clicking on the corresponding project at the
bottom of the workspace window. This will only show the files used by the Active project in the

workspace window as shown in the following figure:

‘..-::- SMBus_Examples Workspace - IAR Embs

File Edit View Project Emulator Tools Window Help

FHA | S| R0 o YR r e AR BURS| LD

| .
M5P430FRE363 -

Files i B
B [ SMB_Slave00_aAllProtocols - MSP430FR5969
[ MSP430FRE_fxx

[ smbuslib

[c1 main.c

Slave_HALc

— B Slave_HALR

= . SMElus Cummands Listc

SME_Master02_WiiteWord_Dimmer |‘ SMB_Slavell_alPratocals:) SMB_Slavell_FeadBy[ 4 [ »
b =

Messages

< (]

Ready Errors 0, Warnings 0

Figure 2: Individual project view in IAR
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The project can be built using F7, Menu->Project->rebuild All, or B .; and downloaded using
Ctrl+D, Menu->Project->Download and Debug, or

»

The example can now be executed.

2.3.2 CCS projects

The CCS projects are not grouped in workspaces. They need to be imported into a workspace
of your choosing. The projects are defined by *.projectspec files, which contain the information
CCS needs to import the project.

Open CCS, and choose Project - Import CCS Eclipse Project. Browse to the \CCS directory
(containing the .projectspec files) of the example you wish to open. CCS will show a list of all the
projects that were discovered in this directory.

Select all or any of the projects and click on “Finish”. The project(s) should appear in the Project

Explorer.
<+ Import CC3 Eclipse Projects | =] = |
. .
Select CCS Projects to Import £
Select a directory to search for existing CCS Eclipse projects,
-
@ Select search-directong® -smbuslib\examples\l\ﬂSP430FR5)0<_6)O<‘{CCS
() Select archive file: Browse...

Discovered projects:

e SMB_Master0_AllProtocols [ChUsers\a02726000\Documents\Work!\Projects\SMBus\smbus430hmspd30-5 Select All
= SMB_Masterll_ReadByteEche [C\Users'al2 \Documents\Work)\Projects\SMBus\smbusd 30\ mspd 3(

.| Deselect All

[,_-:, SMB_Slavel2_WriteWordDimmer [C:\Uzers 600% Documents\ Werk\Projects\5MBus\smbusd 30\ msp)

0\Docurnents\Work\Proje

4| 1 b

Automatically import referenced projects found in same search-directery

Copy projects into workspace

Open the Resource Explorer and browse available example projects...

@j [ Finish ] [ Cancel

Figure 3: Importing CCS projects
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The active project can be selected by simply left-clicking on the project and it will be highlighted
with bold letters as shown in the following figure:

File Edit View Navigate Project Scripts Bun  Window Help
rﬁv 2 QV$VQWVU“ = Quick Access ﬁ|

[T Project Explorer 53 EE Y= 0O
b & SMB_Master00_AllProtocols

s

> = SMB_Masterl] _ReadPate Echo

SME_Master02 WriteWord Dimmer [Active - MSPA20FR5060
I = SMB_Slaveli AitProtocots

| = SMB_Slavedl_ReadByte_Echo

s

> = SMB_Slavel2_WriteWord_Dimmer

[Zl Problems 53

0 iterns

Description Resource

<

s

Full Licenseg = SMB_Master02_WriteWord_Dimmer

Figure 4: Active project in CCS

The project can be built using Ctrl+B, Menu—>Project->Build All, or % .; and downloaded using
F11, Menu->Run->Debug, or ﬁ).

The example can now be executed.
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3 Example Descriptions

3.1 General Instructions
This section contains instructions that are common to all SMBus examples.

Specific instructions for each example are provided after these general instructions.

3.1.1 Nomenclature
The SMBus protocols shown for all examples have the following syntax:
Example:

1 7 1 1 8 1 8 1 1

S | SlaveAddr |Rd [A |[Data |A |[PEC] |[A] | P

Master to
Slave

Slave to
Master

S: Start/Repeated Start

SlaveAddr: Slave address (found in Table 2)
Wr: Write bit (0)

Rd: Read bit (1)

A: Acknowledge (‘1’ = NACK, ‘0’ = ACK)

P: Stop

[PEC]: Optional PEC if enabled

[A]: Optional ACK/NACK slot if PEC is enabled

3.1.2 Hardware Connection

A basic connection shown in Figure 5 between Master and Slave is required in order to execute
the examples.

Examples Guide: MSP430 USB APl Examples 9
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Vcc

Rp Rp

Figure 5: Basic connection between Master and Slave
The pins used for SDA and SCL for the supported derivatives are described in Section 2.2.

The value of the pull-up resistors (Rp) will depend on the system’s VDD and the bus’
capacitance. Typical values are in the range of 1KQ-10KQ.

3.1.3 Building and executing the examples

1. Select an example from Table 2. All examples include projects and source code for both a
master device and a slave device. These examples are named as follows:

- SMB_MasterXX_NameOfProject
- SMB_SlaveXX_NameOfProject

2. Select a MSP430 device for the master and slave. All projects can be executed in the
supported devices listed in Table 1. Note that the master and slave don’t have to be from the
same family of devices necessarily.

3. Connect master and slave devices as described in Section 3.1.2.
4. Open, build and download the corresponding projects as described in Section 2.3.

5. Check the results as described in the “Executing the Example” section of the individual
example.

Examples Guide: MSP430 USB API Examples 10
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3.2 00_AllProtocols

The purpose of this example is to show the implementation of all the SMBus 2.0 protocols.

3.2.1 Master Implementation

The example sends each protocol one by one as shown in the following flow diagram:

</OO_AII ProtocoI;>
T

Init MCU

\ 4

Init SMBus

v

QuickCMD » SendByte

ReadByte

\ 4

ReceiveByte > WriteByte

\ 4

BlockWBIlockR-
ProcessCall

< BlockRead < BlockWrite < ProcessCall < ReadWord

Figure 6: MasterOO_AllProtocols flow diagram

The data sent for each command can be modified as needed, but the default example expects
the following behavior:

- QuickCMD: The slave should simply toggle its LEDO
- SendByte: Sets the pointer to read the Demo Version

- ReceiveByte: Reads the pointer which is expected to be the Demo version set by
SendByte

- WriteByte: Writes the value OxAA to the slave’s IOPort (more details in Section
3.2.2)

- ReadByte: Read I0OPort (more details in Section 3.2.2)

- ReadWord: Read ADC result from slave (more details in Section 3.2.2)

- ProcessCall: Gets the result of multiplying 02h x 10h

- BlockWrite: Write a string on the slave

- BlockRead: Reads the string written in BlockWrite

- BlockWBIlockR-ProcessCall: Calculate CRC of three bytes: 01h, 02h, 03h

Examples Guide: MSP430 USB API Examples 11
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3.2.2 Slave Implementation

The slave implements different commands using various SMBus protocols. The list of
commands is shown in the following table:

Table 6: Slave00_AllProtocols — Slave commands

Function ‘ CMD SMBus Protocol

Quick Led Toggle | - QUICK COMMAND

Read_Reg Ptr - RECEIVE_BYTE

Set Reg Ptr 00h-03h | SEND BYTE

Write Reg 10h-13h | WRITE BYTE

Read Reg 20h-23h | READ BYTE

Read ADC ch 30h READ WORD

Mult Bytes 40h PROCESS CALL

Write String 50h BLOCK WRITE

Read String 51h BLOCK READ

Calc_ CRC 60h BLOCKW_BLOCKR PROCESS CALL

* For a description of the SMBus Protocols, please refer to the SMBus 2.0 specification.

The functions of the commands are very simple, but they are intended to be used for
demonstration purposes or as a template for developers. These functions are described in more
detail in the following sections.

3.2.2.1 Quick_Led Toggle
Description: Toggles LEDO.
Protocol: Quick Command.
Format:

1 7 1 1 1

S SlaveAddr |[Wr [A | P

Examples Guide: MSP430 USB API Examples 12
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3.2.2.2 Read_Reg_Ptr

Description: Read the contents of a virtual register pointer, initialized to Reg0, or set by
Set_Reg_Ptr. The slave defines the following 4 virtual registers:

Table 7: Virtual registers of Slave00_AllProtocols example

Register Description

Reg0 SMBus Status (check definition of SMBus_ Status in SMBus Library documentation)

Regl SMBus Control (check definition of SMBus_Control in SMBus Library documentation)

Reg2 IOPort. When written, it writes to PxOUT register of the IOPort defined in Table 3; when
read, it reads PxIN register of the same IOPort.

Note that an Input switch defined in Table 3 is implemented in the same IOPort, allowing
users to read the status of the switch by reading Reg2.

Reg3 Demo Version. Read-only register returning the version.

Protocol: Receive Byte
Format:

1 7 1 1 8 1 8 1 1

S | SlaveAddr |Rd |A | Resp |A |[PEC] |[A] | P

Resp: Contents of virtual register

3.2.2.3 Set_Reg_Ptr

Description: Changes the virtual register pointer. The contents of the register can then be read
using Read _Reg_Ptr.

Protocol: Send Byte
Format:

1 7 1 1 8 1 8 1 1

S |SlaveAddr |Rd |A |cmD [A |[PEC] |[ALlP

CMD:
0x00: Change pointer to Reg0
0x01: Change pointer to Regl

Examples Guide: MSP430 USB API Examples 13
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0x02: Change pointer to Reg2
0x03: Change pointer to Reg3
3.2.2.4 Write_Reg
Description: Writes directly to a virtual register defined in Table 7.
Protocol: Write Byte
Format:
1 7 1 1 8 1 8 1 8 1 1
S | SlaveAddr Rd |A |CMD | A | Data A |[PEC] |[A] | P
CMD:
0x10: Write Reg0
0x11: Write Regl
0x12: Write Reg2
0x13: Write Reg3
Data: Byte written to virtual register.
3.2.2.5 Read_Reg
Description: Return the contents of a virtual register defined in Table 7.
Protocol: Read Byte
Format:
1 7 1 1 8 1 1 7 1 1 8 1 8 1 1

S | SlaveAddr |Wr |A |CMD | A |S | SlaveAddr | Rd | A Resp | A |[PEC] |[A]|P

CMD:
0x20: Read Reg0
0x21: Read Regl
0x22: Read Reg2
0x23: Read Reg3

Resp: Contents of the virtual register.

Examples Guide: MSP430 USB API Examples 14
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3.2.2.6 Read_ADC ch

Description: Return the latest ADC result of the channel specified in Table 3. Note that this
example performs continuous conversions of the ADC channel triggered by a timer.

Protocol: Read Word
Format:

1 7 1 1 8 1 1 7 1 1 8 1 8 1

S | SlaveAddr |Wr |A |CMD | A |S | SlaveAddr | Rd A RespL | A | RespH | A

8 1 1
[PEC] | [A] | P
CMD: 0x30

RespL/RespH: Latest ADC result.

3.2.2.7 Mult_Bytes
Description: Returns the result of the multiplication of two bytes.
Protocol: Process Call.
Format:

1 7 1 1 8 1 8 1 8 1 1 7 1 1

S | SlaveAddr |Wr |A |CMD | A | Datal | A Data2 A S SlaveAddr Rd A

8 1 8 1 8 1 1

RespL | A |[RespH | A |[PEC] |[A] | P

CMD: 0x40
Datal/Data2: Multiplier and multiplicand
RepL/RespH: Result of multiplication

3.2.2.8 Write_String
Description: Write a string in memory.
Protocol: Block Write

Format:

Examples Guide: MSP430 USB API Examples
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1 7 1 1 8 1 8 1 8 1 ... 8 1 8 1 1
S | SlaveAddr |Wr |A |[CMD [A |Len [A |Datal [A |...|DataN | A | [PEC] |[A]|P

CMD: 0x50

Len: Length of string (1 to 32)

Datal...DataN: 1 to 32 bytes of data which will be written to string
3.2.2.9 Read_String

Description: Return a string stored in memory.

Protocol: Block Read

Format:
1 7 1 1 8 1 1 7 1 1 8 1 8 1

S | SlaveAddr Wr |[A |[CMD|A |S | SlaveAddr | Rd A Len

A | Respl | A

8 1 8 1 1

RespN | A |[PEC] |[A]|P

CMD: 0x51
Len: Length of string (1 to 32)
Respl...RespN: 1 to 32 bytes of data with the contents of the string

3.2.2.10 Calc_CRC
Description: Calculates and returns the CRC of an array of bytes.

Protocol: Block Write Block Read Process Call

Format:
1 7 1 1 8 1 8 1 8 1 ... 8 1 1 7 1 1
S | SlaveAddr | Wr | A| CMD |A|Len | A| Datal | A| ... | DataN | A | S | SlaveAddr | Rd | A
8 1 8 1 ... 8 1 8 1 1
RespLen | A | Respl A ... | RespN A [[PEC] |[A]|P

CMD: 0x60
Examples Guide: MSP430 USB API Examples 16
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Len: Length of the array of bytes (1 to 32)
Datal...DataN: Array of data

RespLen: Array of data in response (2 bytes for CRC)
Resp1...RespN: Result of CRC

3.2.3 Executing the Example
Follow the steps described in Section 3.1.3 to load the example to both devices.

Executing the example should result in the Slave device toggling LEDO at a fast frequency due
to QuickCMD and/or WriteByte.

The results can be better observed by debugging the devices or using a logic analyzer. Using
the first approach, the master application can be executed step-by-step in IAR or CCS observing

the responses.

Figure 7 shows the results of executing the “ReceiveByte” command which will return the
contents of the Reg3 (Demo Version).

Examples Guide: MSP430 USB API Examples 17
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SMB_Master00_AllProtocols
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Figure 7: Debugging 00_AllProtocols example in CCS

The results can also be observed with a logic analyzer as shown in Figure 8.

Q Saleae Logic 1.1.15 - [Connected] - [16 MHz, 100 M Samples] =Nren X
[100 M samptes = [l16mHz = || Start |
Quick | | .
Send Byte Receive Byte
command A ¥t

- - . o
) WoasT 003 T e 0 W (i)
asurements

Figure 8: Results of 00_AllProtocols example using Logic Analyzer
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3.3 01_ReadByte Echo

This example shows a very basic implementation of ReadByte commands with a slave echoing
the byte received from the master.

3.3.1 Master Implementation

The master sends an incrementing command using the Read Byte protocol. Waits for the
response and checks if the response is the same as the command sent. This is shown in the
following flow diagram:

/ S
| 01_ReadByte_Echo
N >

Init SMBus

Command =0

ReadByte

Is response OK and

LEDO OFF == command?

LEDO ON

‘ Command++ ‘

l

Figure 9: Master01_ReadByteEcho flow diagram

3.3.2 Slave Implementation

The slave device in this application simply echoes the command sent by the master. It doesn’t
have any specific commands assigned or makes any distinction between them.

For a description of the SMBus Read Byte protocol, please refer to the SMBus 2.0 specification.
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3.3.2.1 Echo Command
Description: Returns an echo of the Command
Protocol: Read Byte
Format:
1 7 1 1 8 1 1 7 1 1 8 1 8 1 1

S | SlaveAddr |Wr [A |CMD|A | S | SlaveAddr |Rd | A Resp | A |[PEC] |[A]|P

CMD: Any value
Resp: Echo of CMD

3.3.3 Executing the Example
Follow the steps described in Section 3.1.3 to load the example to both devices.

The results of the execution can be observed on LEDO of the master which should stay off;
unless the communication with the slave is interrupted (i.e. pressing the reset button on the
slave).

The pin used for LEDO depends on the device and it’s listed on Table 4.

The results can also be observed using the debugger or a logic analyzer as shown in the
following figure:

Q Saleae Logic 1.1.15 - [Connected] - [16 MHz, 100 M Samples]

[100 M Samples = | (16 MHz || Start

Figure 10: Results of 01_ReadByte Echo example using Logic Analyzer

3.4 02_ WriteWord_Dimmer

This example shows a very basic implementation of a WriteWord command controlling a LED
dimmer on the slave.
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3.4.1 Master Implementation

The master sends a WriteWord command which changes the duty cycle of a PWM controlled by
the slave. The duty cycle starts at 0%, increases gradually to 100% and restarts.

| 02_WriteWord_Dimmer

Init MCU

v

Init SMBus

v

‘ DutyCycle=-0 ‘

A 4

WriteWord

v

Command sent

LEDO OFF oK?

LEDO ON

¥

DutyCycle++ ’—

Y

DutyCycle=-0

Figure 11: Master02_WriteWord_Dimmer flow diagram

3.4.2 Slave Implementation

The slave device in this application implements a single Write Word command which controls
the PWM duty cycle. The PWM output depends on the device and is described in Table 5.

For a description of the SMBus Write Word protocol, please refer to the SMBus 2.0 specification.
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3.4.2.1 Set Duty Cycle
Description: Sets the duty cycle of the PWM

Protocol: Write Word

Format:
1 7 1 1 8 1 8 1 8 1 8 1 1
S | SlaveAddr Rd |[A |CMD |A |DataL [A | DataH |A |[PEC] |[A] | P

CMD: 0x10

DataL/DataH: Duty cycle from 0x0000 to OxFFFF. With 0x0000 being 0% and OxFFFF being

100%.

3.4.3 Executing the Example

Follow the steps described in Section 3.1.3 to load the example to both devices.

The results of the execution can be observed if an LED is connected to the PWM output shown

in Table 5. The LED will increase gradually until it reaches 100% and then it will restart.

The results can also be observed using a logic analyzer as shown in the following figure:

Q Saleze Logic 1.1.15 - [Connected] - [16 MHz, 100 M Samples]

[100 M Samples | [16MHz  ~ | | Start ]

0:31 Uzx] OdF T OES

0:36 Ol

s N T

[=[=] = ]

Figure 12: Results of 02_WriteWord_Dimmer example using Logic Analyzer
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